Basic Utilities in Ubuntu Linux

In the previous chapter we looked at how to operate a computer with Ubuntu Linux OS. We will
further expand that discussion by looking at some basic utilities that Ubuntu Linux provides. In this
chapter we will introduce you to terminal, gedit text editor; we will see how to manipulate files
and directories. We will have a look at the calculator application. As mentioned earlier Linux also
provides some inbuilt applications for entertainment. We will have a look at GNOME image
viewer, thythmbox music player, totem movie player and gimp image editor.

An Introduction to the Terminal

If you want to use the CLI in Ubuntu, there are two choices. You may use one of the 6 text
mode virtual terminals in Ubuntu by pressing CTRL+ALT+Fn key combination, where 7 is the
terminal number (1-6). These virtual terminals provide you the original plain vanilla text mode
experience, with the addition of a small number of colours for displaying the text. Here you
cannot have your CLI session and the GUI programs side-by-side. Also the use of very
convenient copy-paste functionality is not available here. It is generally used when for some
reasons; you cannot start the graphical session. If we have already started a graphical
session, we may also have a CLI session running as a GUI program using the GNOME
Terminal (or the Terminal). It provides a CLI environment inside a GUI window. It
provides much more attractive display and allows us to have multiple terminals. Other GUI
programs on the screen can coexist at the same time. It allows us to resize and reposition
the windows for simultaneous use. It also allows us to copy text from one program (GUI or
Terminal) and paste in the other. In this section we discuss how to use this program.

Using the GNOME Terminal

The Terminal can be started by | W Terminal Help
following the menu chain

2 © @ jignesh@jignesh-laptop: ~

Applications — Accessories —
Terminal or by pressing the
shortcut key CTRL+ALT+T.
The typical screen of the
terminal will be somewhat
similar to the one shown in
figure 8.1.

As can be observed in figure
8.1 the appearance of the

screen is not so attractive. We
can tweak the appearance easily Figure 8.1 : The GNOME Terminal
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to get different look as shown in figure 8.2. The Terminal, being a GUI window, can be moved,
resized, minimized and maximized just like any other widow. When the entire contents of the
CLI screen cannot be displayed in the window, it provides scrollbars; again, just like any other

graphical program.

One major limitation of the text mode screens is that they can only display a fixed number of lines
of text. If some command produces more output than can fit in the screen, the initial part of the
output simply scrolls up and out of the screen and is lost (certainly, there are commands that
display long output screen-by-screen, but using them means we have to type some extra
characters. Also, the user has to anticipate that there will be more output than the screen can
accommodate before running the commands and use this facility.). On the other hand, the
Terminal stores the last several (512 by default) lines of output in memory and allows the user
to scroll up and down through them.

2 © @ jignesh@jignesh-laptop: ~
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jignesh@jignesh-laptop:~$ ls "
bir Documents examples.desktop Pictures Templates Video:
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Figure 8.2 : Terminal After Changing Properties

Sometimes, we may want to have more than one terminals open. For example, while we are
working in a terminal, we may need to use some command, but we might have forgotten
how to use it. Fortunately, Unix and Linux has had online manuals from the early days.
You may read the manual without disturbing the current session in a second terminal window
(see figure 8.3).

The Terminal even supports multiple tabs as shown in figure 8.4. Each tab holds a separate
terminal. We may create a new tab using the File — Open Tab option, or the SHIFT+CTRL+T
shortcut key. We may switch between the tabs by clicking on the tab titles using the mouse or
the CTRL+ALT+PgUp and CTRL+ALT+PgDn shortcut keys. We may also use the shortcut keys
ALT+n to switch to the n™ terminal. A tab can be closed by clicking its close button using the
mouse or the shortcut key SHIFT+CTRL+W.

We may copy text from one terminal and paste in another to save typing. We may even copy
text from some other GUI program (like the OpenOffice.org Word Processor or the Firefox
browser where you might have some valuable help document open) and paste in the Terminal.
We may select these options from the Edit menu or use the Terminal’s slightly-different-from-
convention keyboard shortcuts SHIFT+CTRL+C and SHIFT+CTRL+V for copy and paste
respectively.
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~=sort=yiRD
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-t
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-t sort by msodification time
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-y with -1t: sort by, and show, access time with
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™ lignesh@jignesh-laptop

Figure 8.3 : Opening Multiple Windows
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--batch-size=NMERGE

merge at most NMERGE inputs at once; for more
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Figure 8.4 : Multiple Tabs in Terminal

The Terminal has the options “Keyboard Shortcuts™ and “Profile Preferences” in the Edit menu.
While the first option allows us to change the keyboard shortcuts, the second one gives us
control over the appearance of the Terminal as well as the some other options like scrolling
(see figure 8.5).
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Figure 8.5 : Profile Preferences in Terminal

When we start the Terminal, a new Linux CLI session is started in it. Unlike the virtual text mode
screens, you are automatically logged into the CLI session you open in a Terminal using the user
name you used to log in to your GUI session. The CLI displays a short text known as the prompt.
By default the prompt is username@systemname:current_directory$, but it is highly customizable.
Observe that in figure 8.2 you are able to see prompt as jignesh@jignesh-laptop:~$. While it is
beyond the scope of this book to go into the details, there are so many possibilities of having functional,
colourful and fancy prompts that one may write a whole book on the topic!

After displaying the prompt, the CLI waits for you to type a command. When you type a command
and press ENTER, the command is executed if there are no errors in the command. Figure 8.1
actually is showing the list of all files in current directory, the command used here is ‘ls’. While
the command executes, it may perform input/output. The CLI waits silently for the command to
terminate. When the command terminates, it ones again springs into action and displays another
prompt. This cycle goes on repeating until you exit the CLI by executing the “exit” command or
by pressing CTRL+D (the Unix end-of-input marker) when you are at the prompt. If some command
is running and you want to stop it for some reason, you have to press CTRL+C. You will learn
more about the Linux commands later.

Manipulating Files and Directories

Ubuntu comes with file browser software called Nautilus. The name Nautilus here refers to the sea
creature, the picture of which is the icon for the Nautilus software (you can see it in Nautilus by
clicking Help — About). When you open any file system location (from the local computer or from
the network) using the Places menu, it actually opens in the Nautilus file browser. It allows us to
browse files as well as directories. Nautilus can be opened by selecting a local or remote (connected
through network) file system from the Places menu. Figure 8.6 shows a sample Nautilus screen.
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Figure 8.6 : Nautilus File Browser

Like many other GUI programs under Linux, it has a menu bar and a toolbar (a series of icons
representing actions) at the top and a status bar at the bottom. Between them, there is a
content pane that displays files and folders. The menu bar and the toolbar provide the ability to
take various actions, while the status bar shows some information pertinent to the current display
(for example, in figure 8.6, it says there are 11 items in the current directory and free space on
the current partition is 6.6 GB). There is also a side pane on the left side of the content pane
that displays some standard locations and bookmarks. One may open any of these locations simply
by clicking on it. The standard locations include the user’s home directory (identified by the
user’s name), the Desktop directory, the root file system (identified simply as “File System”),
Network, which displays a list of other computers connected with this computer through a network

(if configured for such use) and Trash.

Opening Files and Directories

You may double-click a file or folder to open it. A folder opens in the same Nautilus window,
replacing the current display of the content pane with the contents of that folder. When you
double-click a file, Ubuntu tries to find out the most appropriate program for opening it, launches
that program and tells it to open the file. If it cannot find a suitable program, it displays a dialog

box as shown in figure 8.7.
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Could not display "/usr/share/gnome-
bluetooth/authorisation-dialogue.ui”.

There is no application installed for Qt Designer file files
Figure 8.7 : Error Message

You may select the application to be used for opening the file or just click OK, in which case
the attempt to open the file will be aborted. Right-clicking on a file gives us an option to open
the file with the associated program (if there is any) as well as an option to open the file with
an application of our choosing (See figure 8.8).
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@ Remember this application for "Qt Designer file" files

Figure 8.8 : Open with Dialog Box

Among the common file types, text files open in the gedit text editor, OpenOffice.org files open
in their respective OpenOffice.org application, image files (pictures) open in the Eye of Gnome
application, music files open with Rhythmbox music player and video files open with the Totem
Movie Player. We shall discuss these programs in coming sections.
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Once we have opened multiple folders the back button in the Nautilus file browser becomes enabled.
We may use this button to go back to the previous folder. Once we go back the forward button
becomes enabled, this button can be used to return to the folder from where we “went back™.
We may also use the Up button to open the parent directory of the current directory. Just above
the content pane, you can see a list of directories that need to be traversed to reach the current
directory from the root directory. You may click on any of these directories to directly open it.
Even after you open a parent directory, Nautilus tries to retain the child directories in this list in
case you may want to visit them again.

Different Views in Nautilus

We shall use the term file system object (or just object) in this section to mean a file or a directory.
Nautilus offers three different ways to look at the list of files and directories in the current directory.
These are the icon view, the list view and the compact view. The view can be selected by using
the view selection tool near the right hand side of the toolbar, or the shortcut keys CTRL+1, CTRLA+2
and CTRL+3 can be used.

In the icon view, each object is represented by an icon (depending on its type) and its name. For
many types of objects, the icons may even provide a thumbnail (a small preview of the object’s
contents) also. The icons are arranged in a grid form. In the compact view, the objects are represented
by very small icons (no preview) and name and are arranged in a vertical list. In the list view also
the objects are represented by a small icon and name and arranged in a vertical list. However,
the list view also displays several other details about the objects like its size, type and the date
when the object was last modified (date of last modification). In this view, we may sort (arrange)
the objects in the ascending or descending order of any of the displayed columns by clicking once
or twice on the column heading. This is very useful to find, say, the largest file or the latest file.
In the List View, there is a “+” (expand) icon just before a folder. Clicking this icon displays the

e 7

contents of the folder as well, at the same time turning the “+” (expand) icon into a “-” (collapse)

icon. Clicking on the “-” (collapse) icon hides the contents of the folder.

Creating Files and Directories

A directory can be created inside the current directory by either selecting the option “Create Folder”
from the File menu or by selecting the same option from the context menu (this applies only to
the icon view and compact view). One may also use the keyboard shortcut SHIFT+CTRL+N.
While a new file can also be created in a similar way using the “Create Document” option,
that option is only useful for creating plain text file. The common way of creating a new file is
to use the corresponding software application. E.g. a new OpenOffice.org text document can be
created using the software’s Writer program; a new image file can be created using the GIMP
image editor.

Selecting Files and Directories

An object can be selected by single-clicking on it. Multiple objects can be selected by single-
clicking them while holding down the CTRL key. A range of objects can be selected by selecting
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one end of the range and single-clicking the other end while holding down the SHIFT key.
Our selection may include only files, only directories or a mix of both as well. The context
menu on a single selection can be invoked by right-clicking the selected object. In case of multi-
selection, right-clicking on any one of the selected objects will invoke a context menu applicable
to all selected objects.

Deleting Files and Directories

After selecting one or more files or directories, pressing the Delete key on the keyboard will delete
the selected objects. Deleting a folder deletes its entire contents, including subfolders, if any, as
well. Normally, a deleted object is not physically removed from the system; it is simply moved
to Trash folder, thus giving the user one more chance to recover it if they deleted the object
unintentionally. There is no easy way to recover an object once it has been removed from Trash
folder also. One may also use the “Move to Trash” context menu option to delete and move
object(s) to Trash.

Renaming Files and Directories

To change the name of an object, select the object and select Rename from the context menu,
or use the shortcut key F2. Then type the new name, and press ENTER. In case you press ESC
in place of ENTER, the rename operation will be cancelled. Only one object can be renamed at
a time.

Copy-Paste Operation

The X Window system maintains a common clipboard. The clipboard is capable of holding one
object at any given point in time, irrespective of its size. Any X Window software may “copy” or
place an object on the clipboard. Since the clipboard can hold only one object at a time, when
another object is copied to the clipboard, the previous object is automatically removed from there
(though it will remain in its original location). Any X Window program (including the one that copied
the object) can “paste” or pick up this object from the clipboard. When a program pastes an object,
it receives a copy of the object, while the copy on the clipboard remains there and the original
object remains in place. Thus, a copied object may be pasted multiple times, each time a new copy
of the object gets created.

In Nautilus, after selecting one or more objects, we may copy them either from the context menu
item Copy or by pressing the shortcut key CTRL+C. The objects can be pasted in any folder
by right-clicking in an empty area and selecting the Paste option. In list view, one may right-click
on the directory’s name just above the content pane and select the option “Paste Into Folder”.
Alternatively CTRL+V can also be used to paste the contents.

Object(s) copied from a folder can be pasted in the same folder also. This will result in their copies
being generated in the same folder, with names suffixed with the text “(copy)”, because there cannot
be two objects with the same name in the same directory. Repeating this operation multiple times
results in names ending in “(another copy)”, “(3rd copy)”, “(4th copy)”, and so on.
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The Copy-Paste operation is used to keep one copy of the object(s) at their original location, while
creating another copy of them at the paste site. When both locations are same, the object(s) get
duplicated in the same directory. Copy-pasting a directory results in its entire contents (including
any files and subdirectories) getting copied.

Cut-Paste Operation

While copy-paste operation is used to create copies of the object(s) while retaining the original
object(s) at their original location, cut-paste operation is used to remove object(s) from their original
location and place them in the new location. Any X Window software may “cut” an object to
place it on the clipboard. At this point, the object is not removed from its original location.
If the user does not paste the cut object anywhere and closes the session or places another
object on the clipboard, thereby removing the first object; then the “cut” operation has no effect.
However, if after the “cut” operation any X Window software performs a paste operation elsewhere,
the object is removed from its original location and placed at the new location (location of paste).
Thus, with cut-paste, there is always only one copy of the object. The cut-paste operation essentially
moves objects around. Cutting and then pasting in the same location has no effect. Once the cut
object is pasted, the clipboard becomes empty and the paste operation cannot be used again until
some object is placed on the clipboard. Cut-pasting a directory moves the directory with all of
its contents.

In Nautilus, after selecting one or more objects, we may cut them either from the context menu
item Cut or by pressing shortcut key CTRL+X. The objects can be pasted in any folder as described
earlier.

The Drag-and-Drop Operation

Like the terminal, we may open multiple Nautilus windows. When we want to move some file system
object(s) from an open folder in one window to an open folder in another, we may arrange the
windows so that both are visible at the same time and then drag the object(s) from the first window
and drop them on the second. Holding the CTRL key while performing drag-and-drop will copy
the object(s).

Bookmarks and Searching

If you use some folder frequently, you may find it cumbersome to reach the folder starting from
one of the built-in places. In such situations, you may open the folder once and select the
option Bookmarks — Add Bookmark. This will add the folder permanently to the side pane as
a bookmark. Now you can open the folder very easily, simply by clicking on the bookmark. The
bookmark is added to the Places menu, too, so it can be selected from there also. And if you
feel the side pane is occupying unnecessary space in the window, you may close it using its close
button. The view menu has an option to show/hide the side pane. Nautilus also has an option to
search for a file/directory in the currently open directory (including its subdirectory, sub subdirectory,
and so on). Just click Go — Search for Files and enter a part of the name of the file you are
looking for.
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The Calculator

OK, so you need to perform some calculations but after purchasing the latest computer you don’t

have a single Rupee left in your pocket to purchase a calculator. You need not worry. Just as you

used the Terminal to use your graphical system like a CLI system, you can use the calculator program
to temporarily convert your millions of calculations per second machine into its poor little sibling.

You can start the calculator program as shown in figure 8.9 by clicking on Applications —

Accessories — Calculator.

As you can see in the calculator program looks strikingly
similar to its hardware counterpart. As a result, it is probably

the easiest program to learn even for computer novices —

just use mouse in place of your fingers. If you are reasonably
good at typing, you may use the number keys or the numeric
keypad on the computer keyboard instead; because that
will increase your speed dramatically. The operators
(+, -, * for multiplication, / for division, C for +, =, etc.)
can also be entered from the keyboard. The CE and
CLR keys both clear the display and reset the current value
to 0. Bksp works just like the Backspace key on the computer
keyboard — it deletes one character to the left of the cursor
every time it is pressed.
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Figure 8.9 : Calculator Program

Also, you may use the Undo facility in the Edit menu if you committed a mistake in entering the

data or operation. Another nice touch, keeping in mind the

needs of IT professionals, is the Insert

ASCII Value option in Edit menu — it allows you to enter a character and inserts the ASCII code

for that character in the display window. Thus, if you ente
inserted in the display window.
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Figure 8.10 : Scientific Mode View
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Some of you might have an elder brother
or sister studying science or engineering.
In that case you might have seen the
scientific calculator. It has a large
number of additional operations useful in
science, mathematics and engineering.
Don’t be disheartened. Just click View
— Scientific, and your -calculator
instantly morphs into a scientific
calculator. (See figure 8.10) There are
Advanced, Financial and Programming
calculators as well (the last one provides
conversions between different number
systems, among other things).
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The Gedit Text Editor

The gedit Text Editor (also known simply as Text Editor) is a graphical editor for plain
(unformatted) text files and documents (see figure 8.11). As a plain text editor, it only saves the
text in the file and never any formatting. The gedit program does allow us to change options like
font, font size, colour scheme etc., but it is important to remember that these options are not
saved in the file but they become the user’s current gedit preferences for all files till they change
these settings again.
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the suondls Award in 1967.
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Figure 8.11 : Gedit Text Editor

Like other key components of the Linux system, gedit supports major portions of the Unicode
character set, including major Indian languages and even substantially different languages like
Arabic (written right-to-left) and Chinese (written by combining a large number of pictograms).
While Ubuntu comes with Unicode fonts to display text in all these languages, support for input
in languages other than English is not included on the installation CD itself to save disk space.
Support for additional languages needs to be downloaded and installed. This process is shown in
Appendix 1.

Some of the more commonly used menu options along with the corresponding shortcut keys are
as under :
o File
¢ New (CTRL+N) Create a new file
¢ Open... (CTRL+0O) Open an existing file
e Save (CTRL+S) Save the current file
e Save As... (SHIFT+CTRL+S) Save a copy the current file under a new name
e Print (CTRLA+P) Print the current file
¢ Close (CTRL+W) Close the current file
¢  Quit (CTRL+Q) Quit (terminate) the gedit program
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o Edit
e Undo (CTRL+Z) If something goes wrong while working on a file, this option can

be used to reverse the effect of the last operation; when used repeatedly, the option
goes on undoing our operations in reverse order

e Redo (SHIFT+CTRL+Z) Reapply the most recently undone operation, this option
can be repeated, too

e Cut (CTRL+X) to cut the text selected with the mouse to the clipboard

e Copy (CTRL+C) to copy the text selected with the mouse to the clipboard

e Paste (CTRL+V) to paste the text in the clipboard at the current cursor location

¢ Preferences In Ubuntu, the Preferences (options) menu is traditionally the last menu
item in the Edit menu. It is this menu that provides options to change font, font size,
colours, etc. for the gedit program
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Figure 8.12 : The Gedit Text Editor After Changing Preferences

Figure 8.12 shows a gedit screen after these options have been changed from their defaults. Some
of the commonly used options are also available as tools (icons) in the toolbar. The gedit Text Editor
supports editing of multiple files at a time. There are two ways of doing this — to open multiple
separate gedit windows (see figure 8.13), or to open the two files in two tabs of the same editor
window (because gedit supports tabbed interface), as shown in figure 8.14.
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Figure 8.13 : Multiple Gedit Windows
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Figure 8.14 : Multiple Files in Different Gedit Tabs

The benefit of the first approach is that we can see multiple files at the same time on the screen
and compare them or easily use one file as a reference while editing another. The advantage of
the second approach is that it requires less screen space. Also, switching between the tabs (files)
is not difficult — we may click the tab heading with the mouse to switch to any tab or use the
shortcut keys ALT+#n to jump to the n™ tab or CTRL+ALT+PgUp/CTRL+ALT+PgDn to move

to the previous and next tabs respectively.

Another interesting feature is that dragging a tab title out of the window creates a new gedit window
and moves the tab to it, while dragging a tab title into an existing gedit window moves the tab
to that window.

If you are editing a large document and want to use the maximum screen space, you may select
the “full screen” mode from the view menu. In this mode the entire screen will be occupied by
the gedit window and only the content pane, where you type, will be visible hiding everything else
including the title bar, the menu bar and the tool bar. The shortcut key for this is F11. You may
return to the normal mode by pressing F11 again. Trying to move the mouse pointer slowly out
of the screen from the top of the screen will make the toolbar visible as a floating window with
one more option “Leave Full Screen” added to it. You may always switch to another program directly
by pressing ALT+TAB.

The gedit Text Editor understands the syntax (grammar) of several computer languages and can highlight
parts of the text using different colours depending on the grammatical roles they play. This makes
reading and understanding easy and may help in identifying some common typing errors early. While
no computer language is covered in your syllabus at this stage, figure 8.15 shows a demonstration
of this capability. This option is provided in the View — Highlight Mode option. Of course, the
files are saved as plain text only and not as formatted (colour-coded) text.
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<html>

<head>

<title>HTML Demo</title>

</head>

<body>

<h1>HTML Demonstration</hl>

<p>This is a <span style="color:red;font-
weight:bold">Demonstration</span> of HTML syntax
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Figure 8.15 : Syntax Highlighting in Gedit

The Search menu provides options to find (search for) specific text in the (large) document. It allows
us to find the occurrence repeatedly till we choose to exit the search. We may also search for
occurrences of some text and replace them by another text. We may go for a one-by-one replacement
of the occurrences, optionally skipping replacement of some occurrences; or we may replace all
occurrences in the entire document if we are sure about doing it. The option “Incremental Search”
continually goes on matching the text as soon as we type each character and highlights all occurrences
of the current text (see figure 8.16). The shortcut keys for these operations are find (CTRL+F),
replace (CTRL+H), find next (CTRL+G), find previous (SHIFT+CTRL+G) and incremental search
(CTRLAK).
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<body>

<h1>HTML Demonstration</hl>

<p>This is a <span style="color:red;font-
weight:bold">Demonstration</span> of HTML syntax
highlighting in gedit.</p>

<p>Have a nice day!</p>

</body>

</html>
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Figure 8.16 : Incremental Search in Gedit
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The gedit Text Editor even has support for checking the spelling of words in your document. It
has built-in dictionaries for some languages. When we choose the option Tools — Check Spelling,
it checks the spelling of every word in our document from the beginning. For every supposed error
that it finds, it suggests a list of words with similar spelling as possible alternatives. It offers options
to ignore the supposed misspelling (only for this occurrence of the word or for all occurrences of
the word) and to change the word with the selected suggestion from the list (for this occurrence
of the word or for all occurrences of the word). Sometimes, a correct word may be flagged as
incorrect spelling by gedit because it may not be there in its built-in dictionary. In such cases, we
may ignore the word or add the word to the user dictionary, so that it never again treats the word
as error even in other documents for this user of the system. The option Tools — Document Statistics
provides information like number of characters, words and line for the current document. Like most
other graphical programs, the Help menu is the last one in the menu bar and provides basic help

in using the software.

The Eye of GNOME Image Viewer

The Eye of GNOME (also known as Image Viewer) is used to view images and picture files. It
opens automatically when we double-click on any image file in the Nautilus file browser. By the
way, it is not displayed in the Applications menu by default, but may be made to appear in the
menu if we wish. Figure 8.17 depicts a picture open in the Image Editor.
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Figure 8.17 : The Eye of Gnome Image Editor
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The software provides all the common operations in the toolbar itself. If you have opened the image
from a folder that contains other images as well, you may use the Previous and Next tools to view
the previous and next images in the folder respectively. The Zoom In and Zoom Out tools can
be used to enlarge and shrink the display of the image (not the original image itself) respectively.
The Rotate Left and Rotate Right tools rotate the image counterclockwise and clockwise respectively,
by 90°. This is especially useful for viewing photographs taken using a digital camera or mobile
phone where we tend to take photographs in portrait mode or landscape mode depending on the
scene/object. Again, the change is made to a copy of the image in main memory and is only temporary,
but we get to save the changed image for permanent storage on the disk using the File — Save
menu option. If we modify some image(s), and then try to close the Image Viewer without saving
them, then the software asks us whether we would like to save the changes. Figure 8.18 shows
an image in its original form and after each step when the operations Rotate Left, Rotate Left, Rotate
Right and Rotate Right are applied in that sequence.

Figure 8.18 : Rotation of an Image

There is also a tool Edit that opens the image in an image editor program, F-Spot by default. However,
we shall not discuss it here because we are going to cover the more powerful and better known
GIMP image editor in a later section. Also, this tool is not visible by default in later versions of
Ubuntu. Some of the more commonly used functionality provided in the menu and not covered by
the default toolbar are as mentioned in table 8.1:

Functionality Description
File — Print To print the image.
View — Image Collection Enables the display of a scrollable bar of thumbnails (small

preview images) of the images in the current folder, we may
click on a thumbnail to see its full view (see figure 8.19)

View — Slideshow Starts showing images in the current folder one by one,
changing images at a fixed interval (shortcut key: F5)

Edit — Undo To undo the changes made by us (one by one)

Edit —» Move to Trash Delete the image and move it to trash, very useful when
you have a large number of images and you want to decide
which ones are to be deleted after looking at them.

114 Computer Studies : 9



Edit — Toolbar Displays several tools, we may add or remove tools to
the toolbar by drag and drop.

Edit — Preferences Allows us to modify some options

Image — Flip Horizontal Replaces the two halves of the image formed by an
imaginary vertical line passing through the center of the
image to their mirror images as seen in an imaginary mirror
at the said line (see figure 8.20)

Image — Flip Vertical Replaces the two halves of the image formed by an
imaginary horizontal line passing through the center of the
image to their mirror images as seen in an imaginary mirror
at the said line (see figure 8.21)

Image — Set as Desktop Sets the current image as the desktop background

Background

Table 8.1 : Functionalities of Eye of GNOME
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Figure 8.19 : Image Collection in Image Editor

Figure 8.20 shows a series of images in which the first image is in its original form while subsequent
images are obtained by flipping the previous image horizontally.
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Figure 8.20 : Horizontal Flipping of Images

Figure 8.21 shows a series of images in which the first image is in its original form while subsequent
images are obtained by flipping the previous image vertically.
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Figure 8.21 : Vertical Flipping of Images

Flipping can also be interpreted as if the image were painted on one side of transparent glass. Such
an image is visible from both sides. The horizontal flipping would rotate the image 180° around
a vertical axis passing through the center of the image while vertical flipping would rotate the
image 180° around a horizontal axis passing through the center of the image (both axes are
shown in respective figures for reference). Please note that the images shown in this section are
readily available in Ubuntu 10.04 and may be copied from the directories /usr/share/backgrounds
and /usr/share/icons/hicolor/scalable/apps into the Pictures directory of your home directory for
practice.

The Rhythmbox Music Player

Rhythmbox is the default music player in Ubuntu. It can be used to play music or audio files from
the computer, podcasts (digital media, especially audio containing human voice(s) broadcast
over the Internet), Internet radio, etc. Rhythmbox can be started from the Applications menu or
by double-clicking any audio file. When started, Rhythmbox does not display any window —

simply adds a small music-player-like indicator to the indicator applet on the right hand side of
the top panel. It almost seems like it didn’t start (if we start it by double-clicking on a file,
the file starts playing). However, on clicking on the said indicator we get the options to start
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and pause the playback, changing to the next or previous track as well as a “Show Rhythmbox”
option to show the actual Rhythmbox window as shown in figure 8.22.
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Figure 8.22 : Rhythmbox Music Player

Selecting Quit from the same menu terminates Rhythmbox, while closing the window by clicking
on the window close button merely hides it in the indicator applet and the playback of song, if
running, continues.

Rhythmbox works just like so many other music player applications. It scans the entire computer
or some directories on it as well as connected removable media for audio files and generates a
“library” (catalog) of music. For each audio file, called “track™, it also stores common information
like the album name, artist (singer), genre (type of music), year of publication, etc. wherever available.
It also allows the user to sort (arrange) and filter the music based on these attributes. At different
times, the user may play music from different albums, by different artists or belonging to a particular
genre, according to the mood. It allows the user to create different sets of songs, called playlists,
to reflect their choices. Later, the user may instruct Rhythmbox to “play the playlist”, Rhythmbox
will automatically play songs from the playlist one after another, either in sequence or in random
order if the user chooses the “shuffle” option.

Rhythmbox also has some “smart” playlists like “My Top Rated”, “Recently Added” and “Recently
Played” that are created and automatically updated by Rhythmbox. The user may also use
recommendations from the popular Last.fm website, which provides automated or user created music
recommendations to users based on the preferences they show or the kind of music they play more.
Rhythmbox provides the usual controls like “Play”, “Previous Track”, “Next Track”, “Loop” (start
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the first song again after the last song in the playlist) and “Shuffle” (play songs in random order).
The “Play” button transforms into “Pause” Once the music starts playing and again becomes “Play”
when the music is paused. Even though Rhythmbox is the default music player that comes with Ubuntu,
we also have the choice to install other free music player software. Rhythmbox does not support
the popular MP3 format out of box because MP3 is a proprietary format covered by patents and
creators of hardware or software MP3 players are often asked to pay royalty to the owners of
the patents. Ubuntu, as a policy, includes only 100% free and open source software on the CD.
But it does allow users to install plug-in software (additional part) that add support for MP3 to
Rhythmbox. It also permits installation of other media players (including those supporting MP3). For
example, VLC is a free multimedia player that supports several audio and video formats and is
widely used.

The Totem Movie Player

Ubuntu bundles the Totem Movie Player for playing video (see figure 8.23). It is a simple video
player with an easy to understand interface. You may run a video in it by double-clicking a video
file. Alternately, you may click Applications — Sound & Video — Movie Player to open it. The
Movie — Open option may then be used to open a video file. The left-central part of the window
is used to display the movie. Below the movie display, a slider marked “Time” has a small button
on it. Dragging this button back and forth, allows us to watch the movie from a particular time
point and to skip or repeat some parts.

Below the time slider are the buttons to move to the previous and next videos and a Play button
that transforms into a Pause button when a video starts playing. A small icon besides that allows
us to watch the movie in full screen mode.
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Figure 8.23 : Totem Movie Player
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In full screen mode, the video is played over the whole screen, leaving only a small bar at the
bottom for essential controls and a button at the top to close the full screen mode and return to
normal mode. A speaker button to the right allows us to adjust the volume. The side bar has options
to search the popular video-sharing site YouTube, to display the current playlist or to display the
properties of the current video.

The Edit menu has the options Repeat (to play again the current movie or playlist when its end
is reached, also known as “loop™) and shuffle. It also allows us to capture screenshots (still pictures)
from the movie currently playing.

Totem movie player comes with support for open video formats. Support for other free, but not
open, formats needs to be downloaded in the form of plug-ins.

The GIMP Image Editor

GIMP (GNU Image Manipulation Program) is a powerful image editor. Even though it is free software,
its image processing capabilities have started competing with costly professional image processing
tools. It has so many features and capabilities that entire books have been written on it, still most
not managing to cover everything that GIMP has to offer. As such, the explanation in this section
has been highly simplified to mask the complexity and provide a quick overview of some basic
concepts and features of this powerful program.

A computer image consists of a rectangular grid of dots called pixels (picture elements). Image
processing generally comes down to manipulation of an image (picture) by performing a series of
operations on it. Even creation of a new image is done by creating an empty image and then
manipulating it. Dozens of image file formats have been developed over a period of decades with
different characteristics and applications. Some of the very common image file formats are JPEG
(JPG), GIF, BMP, PNG SVG While there are dedicated conversion tools, image processing software
can also often be used as a format converter. GIMP’s native file format is XCF, but it has input
filters for importing images in most other common formats and output filters for exporting to a wide
range of image formats. Hence a file in one format may be opened in GIMP and saved in another
format to achieve conversion.

Since different image file formats have different characteristics, you may be warned that some
features may be lost if you save the image in the new format. GIMP’s own XCF format supports
saving in the image file all the features that GIMP itself supports. You may also be prompted
to specify various options for conversion. You may change the options, or accept the default
values for them.

GIMP is not included on the Ubuntu CDs by default. Hence we need to install it first by going
to Ubuntu Software Center. Once installed, we may start it by clicking Applications — Graphics
— GIMP Image Editor or by right-clicking an image file and selecting Open With — GIMP
Image Editor. GIMP has a interface that consists of three independently positioned and sized
windows by default (See figure 8.24).
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Figure 8.24 : GIMP Image Editor

Later versions also provide the option of a simpler single window interface. We start working
with GIMP by either opening an existing file or creating a new one from the File menu. There are
three windows — the main window holds the image we are manipulating, the Toolbox and a
window holding several additional tools. The Toolbox contains a large number of tools in the
upper part. Hovering over a tool displays a tooltip identifying the tool. The lower part displays
various options available for the currently selected tool. The general way of working is to select
a tool from the upper part, change the options in the lower part if needed and then apply the tool
using the mouse in some part of the image in the main window. The menu system also contains

a large number of operations to choose from.

An image may also have some transparent areas. By default GIMP displays the transparent
areas using a checkered pattern. However, we may change this behavior from the Edit —
Preferences menu item. The Display section has a Transparency subsection that allows us to set
the check size as well as check colour. We may set the check style to “white only”, if we wish.
If an image having transparent areas is overlaid over another image, in the transparent portions

we can see the image behind it. (See figure 8.25).
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Figure 8.25 : Transparency and Overlaying

Did you wonder how the first image was overlaid over the second ? GIMP, like other sophisticated
image editors, supports layers. Figure 8.24 shows the “Layers” tab in the right-hand side window.
It allows us to create and manipulate layers. Each layer can hold one image, parts of which may
be transparent. Each layer can be manipulated individually. The order of layers can also be changed.
You may think of an image with multiple layers as consisting of multiple transparent sheets of glass
stacked on top of one another, with images painted on them, leaving some parts transparent. When
viewed from the top, we see the image on the top sheet, but through its transparent parts we can
see the image on the second sheet, third sheet, and so on. Figure 8.26, taken straight from the
GIMP manual, explains this concept.

Quite often, you may want to select a portion of the image and perform some operation(s)
only on the selected area. GIMP provides various selection tools for this purpose. For
example, the Rectangle Select tool allows us to select rectangular (including square) areas. By
default, making a new selection removes the previous selection (though this behavior can be

changed).
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Figure 8.26 : Concept of Layers

GIMP has a notion of the current foreground colour and the current background colour. These colours
are used in various tools for drawing and filling. Hence, before using those tools, we should set
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the foreground and background tools the way we want. The bottom-most tool in the upper part
of the toolbox (one rectangle covering a major part of another rectangle) is used to set these options.
In fact, the colour of the partially covered rectangle is the current background colour and the colour
of the rectangle covering it is the current foreground colour. By default, these are white and black
respectively. To change the foreground or background colour, click on the appropriate rectangle in
the tool, which will open the colour selection dialog as shown in figure 8.27.
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Figure 8.27 : Changing Foreground Colour

The dialog box displays the old (original) colour and the current (new) colour. Initially both are
same. While there are so many ways of selecting the colour we want, we shall use one of the
two simple methods. First, if you know the exact English name for the colour (this should not be
difficult for simple colours like red or orange), you may type the first letter of the colour name
in the HTML notation field, which will open up a list of all colours starting with that letter along
with previews. You may select the colour you want by clicking on the colour name. The other simple
way is to select the colour you want from the vertical rainbow strip besides the large shaded rectangle
(try to be as precise as possible). This will fill the large rectangle with shades of that colour. Now
click at a point in the rectangle that has the exact shade you want. The current colour field will
change to reflect your choice. If you like it, click OK to set the colour, otherwise continue to

experiment.

Creating New Image

Now, we shall start by creating a blank image and perform a series of operations in sequence.
Each stage of the operations is shown in figure 8.28. Continue to refer to it as each operation
is described. First, create a new image by selecting File — New option from the menu. You need
to specify the size of the image, which may be in terms of pixels, inches, millimeters, etc. The image
is initially blank (see figure 8.28 a). Now, select a rectangular area in the image. First click on
the Rectangle Select tool, move the mouse pointer to one corner of the rectangle you want to draw
on the image, press the left mouse button and drag to the other corner. Finally, click inside the
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rectangle to finalize the selection. (See figure 8.28 b). At this point, we have only selected an area
in the image, but we have not changed anything in the image.

a: Blank Image b : Rectangle drawn

Figure 8.28 : Processing Image in GIMP

Selections are transient in nature and a new selection removes the previous one by default. Now,
let us draw a line along the border of the selection. Click the menu option Edit — Stroke Selection,
which opens a dialog box (see figure 8.28 c). We may select the thickness of the line and the
dash pattern (whether to use a solid line or a dashed line) among a host of options. The line will
be drawn using the current foreground colour (see figure 8.28 d).

While a square selection can be done in the same way, to get an exact square follow these steps.
First select the same Rectangle Select tool and start dragging from one corner of the square you
want to select. Without releasing the mouse button, press the SHIFT key, which will force the rectangle
to be a square. When you get the right size, release the mouse button first, and then the SHIFT
key. As GIMP is very powerful software with so many options, different combinations of mouse
and keyboard actions and even the order in which these actions are taken result in different operation
taking place. Figure 8.28 e shows a perfect rectangle drawn in this way.
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Figure 8.28 : Processing Image in GIMP
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We may use the Ellipse Select tool to select ellipses and, with SHIFT, perfect circles in the same
way (figure 8.28 f and figure 8.28 g respectively).

f Ellipse tool g: Ellispe and circle
Figure 8.28 : Processing Image in GIMP

The Free Selection tool allows us to select an area of arbitrary shape. Start at any one point of
the shape you want to select and, holding down the mouse button, move the mouse cursor as if
you were drawing with a pencil. If a part of the shape is a straight line, release the mouse button
when drawing that part, which will draw a perfect straight line. You must close the shape by ultimately
reaching back to your starting point before releasing the mouse button because all selections must
be closed shapes (see figure 8.28 h). A polygon consisting of arbitrary shapes can be drawn using
the Free Selection tool. To draw a polygon, just go on clicking on the points of the polygon in
sequence (do not hold down the mouse button), clicking on the first point again at the end (See

figure 8.28 i).

h: Arbitrary shape i- Polygon

Figure 8.28 : Processing Image in GIMP

If you want to fill a shape with some colour, there are two options. Immediately after selecting
the shape; select Edit — Fill with FG Color menu option, which will fill the selection with the
current foreground colour as shown in figure 8.28 j. After this, you may change the
background colour and stroke the figure to get a border, if you want. The other alternative is
to select the Bucket Fill tool and click on any point inside the shape we want to fill (See
figure 8.28 k).
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Figure 8.28 : Processing Image in GIMP

It will only fill the innermost immediately enclosing shape (see figure 8.28 1). You may have to click
repeatedly to fill different parts of a shape as shown in figure 8.28 m). This gives you an opportunity
to fill different parts of a shape with different colours (by changing the foreground colour in between),
if required. If you click in an open area or a shape that is not closed by solid colour from all
sides, the fill colour will “spill over outside™ and fill all open areas of the image.

4 PO
sz;

I Filling inner area m: Filling inner area

Figure 8.28 : Processing Image in GIMP

For example, clicking on the point marked with green in figure 8.28 n, the colour will flow out
and fill all open areas as shown in figure 8.28 o because the shape in question is open. Fortunately,
if you commit any mistake and want to correct it, you can always undo your last actions in reverse
order by selection Edit — Undo option or the shortcut key CTRL+Z. We undo the last fill before

g b

n: Selection of green point o: Outside fill

Figure 8.28: Processing Image in GIMP
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But wait! Did you not read that all selections must be closed ? Then how did we land with an
open shape in the first place ? Another question: how do you put a dot in the figure or draw a
line ? Well, the answer to these questions is — using the pencil tool. When you select the pencil
tool and click anywhere in the image, a tiny circle (its size can be set) is drawn and filled with
the foreground colour. You may go on clicking like this to create more circles at different locations
in the image. If you hold down the shift key when clicking, a straight line is drawn in place of
a circle, connecting the previous point to the current one. One may draw such lines anywhere one

wishes and shapes created using such lines need not be closed.

What do you do if you are making a pencil drawing and want to correct something ? You use
an eraser. Indeed, GIMP also provides an eraser tool that can be used to erase parts of the drawing.
Unlike a real world eraser, GIMP’s eraser can change both the size and the shape as per your
wish. Figure 8.28 p shows the image after we erase some portion with a large circular eraser. Using
the Text tool one may write text in the image (see figure 8.28 q). One gets to choose the font,
font size, colour, etc. Clicking anywhere in the image brings up a dialog in which you may type
the text. The text appears at the location where you typed. It can be corrected or moved immediately
after creation by clicking inside. You correct the text in the dialog that opens and move the text

by dragging it (ignoring the dialog).

Great Image Processing Program

p: Erasing shapes q: Writing Text

Figure 8.28 : Processing Image in GIMP

The act of cutting certain parts of the image out is called cropping. The Crop tool is used to crop
the image. After selecting it, we use drag and drop to draw a rectangle on the image (see figure
8.28 r). The rest of the image is darkened to highlight the rectangle. If we click inside the rectangle
we have drawn, the image is cropped to that rectangle, i.e. everything outside that rectangle is “cut
out ” (removed) from the image (see figure 8.28 s). An image can be “scaled”, i.e. its size changed
(enlarged or reduced) by selecting the menu item Image — Scale Image. In the dialog that appears,
we change either the height or width and the other will automatically change correspondingly to maintain
the “aspect ratio” (ratio of width to height). If we click on the little chain symbol between these

two, it breaks the link and allows us to change both arbitrarily, not caring to maintain aspect ratio.
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If you do this on a person’s photograph, the person may look fatter or thinner in the scaled image.
And yes, if you remember the facilities provided by the Eye of GNOME viewer, what that simple
program can do, GIMP can do too. An image can be rotated or flipped by selecting the appropriate
options from the Image — Transform menu item. Figure 8.28 t shows the image after rotation by

~

90° clockwise.

r: Cropping image s: Scalling image

t- Rotating image

Figure 8.28 : Processing Image in GIMP

Even though we have covered only basic features of GIMP in this text, it has probably become
clear to you that GIMP is a very powerful and feature-rich image editor.

Summary

In this chapter we discussed some of the utility programs that are available under Ubuntu.
The Nautilus file manager program allows us to manipulate files and directories with ease using
a GUL The calculator program lets us perform arithmetic and scientific calculations quickly,
easily and accurately. The gedit Text Editor can be used to create and manipulate text files.
There are built-in applications for viewing multimedia content like pictures, audio and video.
GIMP is an extremely powerful image editor program that can be used for various types of
image processing tasks.

EXERCISE

1.  Write down the benefits of the GNOME Terminal over ordinary text terminal.

What are the preferences in Terminal ?

Explain how the CLI works.

What are the components of the Nautilus window ? What is the function of each ?
Explain different views in Nautilus and how to switch between them.

Explain the cut, copy and paste operations.

NS REwN

Explain the checking of spelling in gedit.
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8.  Describe the image viewing features of Eye of GNOME.
9.  Describe the image editing features of Eye of GNOME.
10. Explain horizontal flipping of an image with the help of a figure.
11.  Explain vertical flipping of an image with the help of a figure.
12. Write down the process of selecting a colour in GIMP.
13. How do you draw a line along the border of a selection ? What options do you have in
performing this operation ?
14. Write the process of drawing a perfect square in GIMP.
15. Write the process of drawing a perfect circle in GIMP.
16. Describe the working of the Free Selection tool.
17. What is cropping ? How is it done ?
18. Choose the most appropriate option from those given below :
(1) What is the shortcut key to start a GNOME Terminal ?
(a) SHIFT+ALT+G (b) CTRLA+SHIFT+T
(¢) CTRL+ALT+T (d) CTRLA+SHIFT+G
(2) How many lines of output are stored in the memory by default by the GNOME
Terminal ?
(@ 251 (b) 512
(c) 521 d 215
(3) What is the shortcut key to switch to the 3 tab in the GNOME Terminal ?
(@) ALT+3 (b) CTRL+ALT+3
(¢) SHIFT+CTRL+3 (d) CTRLASHIFT+3
(4) What is the shortcut key to paste text in the GNOME Terminal ?
(a) SHIFT+ALT+P (b) SHIFT+CTRL+P
(c) SHIFT+CTRLA+P (d) SHIFT+CTRL+V
(5) Which command is used to come out of the CLI session ?
(a) finish (b) terminate
(©) quit (d) exit
(6) What is the name of the default file browser in Ubuntu ?
(a) Notorious (b) Nautilus
(c) Notirus (d) Nautirus
(7) Which program is used to open text files by default ?
@ v (b) gedit
(c) Plain Text Editor (d) Nautilus
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(8) Which program is used to open image files by default ?

(@) gedit (b) GIMP
(c) GNOME (d) Eye of GNOME
(9) Which program is used to open video files by default ?
(@) Totem Movie Player (b) Tutom Video Player
(c) VLC Player (d) Eye of GNOME
(10) Which of the following is not a view in Nautilus ?
(@) Icon View (b) List View
(c) Files View (d) Compact View
(11) Which of the following view in Nautilus allows sorting files by clicking the column
heading ?
(@) Icon View (b) List View
(c) Files View (d) Compact View
(12) Which of the following view in Nautilus displays + or — against folders ?
(@) Icon View (b) Files View
(¢) Compact View (d) List View
(13) An object that is copied is stored on -
(a) the whiteboard (b) the blackboard
(c) the chopboard (d) the clipboard
(14) Which operation creates a new copy of the object ?
(@) copy followed by paste (b) cut followed by paste
(c) paste followed by copy (d) paste followed by cut
(15) Which operation moves the object ?
(a) copy followed by paste (b) cut followed by paste
(c) paste followed by copy (d) paste followed by cut
(16) Which of the following is not a type of calculator available in Ubuntu ?
(a) Advanced (b) Binary
(¢) Scientific (d) Programming
(17) What is the shortcut key for undoing the last action in gedit ?
(@ CTRL+U (b) ALT+U
(c) CIRLAZ (d) ALT+Z
(18) The default image viewer in Ubuntu is known as -
(@ See of GNOME (b) View of GNOME
(c) Eye of GNOME (d (D) Sea of GNOME
(19) What is the name of the default music player in Ubuntu ?
(a) Rhythmbox (b) Banshee
(c) VLC (d) Media Player
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(20) What is the full form of GIMP ?
(a) Great Image modification Program
(b) General Image Modification Program
(¢) GNU Image Modification Program
(d) GNU Image Manipulation Program
(21) Which is GIMP’s native file format ?

(@) XPG (b) XCF
(c) JPG (d) PNG
(22) Which tool is used to fill a shape with colour in GIMP ?
(a) Bucket Tool (b) Fill Tool
(c) Bucket Fill Tool (d) Shape Fill Tool
(23) Which tool can be used to draw open shapes ?
(a) Line Tool (b) Pen Tool
(c) Bucket Fill Tool (d) Pencil Tool
(24) The act of cutting certain parts of the image out is called -
(a) deleting (b) cropping
(c) scaling (d) erasing
(25) The act of enlarging or shrinking an image is called -
(a) deleting (b) cropping
(c) scaling (d) erasing
LABORATORY EXERCISE
1.  Start the Terminal. Close it using the appropriate command. Again start it and close it using
a key combination.
2.  Type the command /s in the Terminal and copy-paste its output into a file opened using
gedit. Note down your observation.
3. Create a directory structure as shown in the following figure in your home directory
(directories are marked in green colour, while files are marked in blue).
tmp
I 1 1
"3
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10.
11.

12.

13.

Now perform the following operations in sequence and draw a figure depicting
the new structure after each operation. When you are presented with a dialog,
try to understand the dialog and the implications of the various choices

provided :

(a) Copy the file f2 into the directory tmp—d2.

(b) Open the file {2 in gedit and type some more content.
(¢) Move the directory d3 to the directory d2 in dI.

(d) Copy the file f1 in tmp—d1—d2 to the same directory.
(e) Copy the file fl in tmp—dl—d2 to tmp—dl.

() Copy the file f1 in tmp—dl—d2 to tmp—d2.

(g) Copy the directory d4 to d3.

(h) Copy the directory tmp—d1—d2 to tmp.

(i) Move the directory tmp—d1—d2 to tmp.

Practise renaming and deleting files.

Open two different directories in two Nautilus windows, place them side-by-side and use

drag-and-drop to move and copy some files from one directory to another.
Open gedit. Change the looks using the Preferences menu.

Type a note on gedit in gedit itself. Be sure to use the facilities described in the chapter

to familiarize yourself with them.

Create a short summary of your gedit note in another file using copy-paste from the

original note.

View some images from the directories mentioned in the text using Eye of GNOME.

Apply the operations mentioned and observe their effect.
Perform the operations in Figure 8.28 yourself.

For each tool of GIMP discussed in the text, show its effect by applying it to an image
and drawing the “before” and “after” images. Also write down the steps of the operation

alongside.

Create simple drawings of the following types :

(a) Landscape (b) Object Drawing

(¢c) Cartoon (d) Free Hand Drawing

Try to apply some effects to existing images.
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( NOTES TO TEACHERS )

e Assignments for all tools may focus on “How to....” activities. The activities may be
reverse engineered from the features discussed in the text or you may use your own
creativity.

e Assignments for GNOME Terminal, Eye of GNOME, Rhythmbox music player and
Totem Movie Player will have to be based on preferences and options.

e Assignment on calculator may ask students to perform some calculation that they have
already learned in mathematics but is too cumbersome or time-consuming to perform by

hand. Questions should not be asked on what they have not learnt.
e Assignment on gedit may concentrate on the windows, tabs, cut-copy-paste operations, etc.
e Assignment on GIMP may be graded

e Simple assignment requiring the knowledge of only one procedure from the text

e Operations that require the use of more than one tool

e Complete tiny projects in image creation and manipulation

e Assignments that require creativity on the student’s part (should not be overemphasized)

e Assignments on GIMP need not have iron-cast requirements, this will permit students to

use their creativity
e Provide some readymade images to be processed to the students.

e Be sure to perform the assignment yourself to ensure they do not use anything not
covered in the text and are within the ability of students in the given timeframe before giving
them to the students.
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